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 Beispiele in Wind River Workbench V4 importieren 1 
 

 
Unter VxWorks 7 und Workbench V4 basieren Real Time Process Workbench Projekte auf 
einem VxWorks Image Projekt bzw. einem VxWorks Source Build Projekt. Aus diesem 
Grund können die ausgelieferten Beispielprojekte nach dem Import in den Workspace nicht 
direkt neu übersetzt werden. Es muss zuerst ein neuer Kontext für das in Ihrem Workspace 
vorhandene Source Build bzw. Image Projekt erstellt werden. Die Vorgehensweise zum 
Import eines Beispiels wird nachfolgend anhand des PROFINET-Beispiels 
rtp_pniocontroller_irt demonstriert: 

1. Wählen Sie "File > Import > Existing Projects into Workspace" und öffnen Sie den Dialog 
"Import Projects". 
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2. Wählen Sie unter "Select root directory" den Ablageort der Beispiele. 

Der Ordner befindet sich in Ihrer VxWorks 7 Installation in folgendem Verzeichnis: 

"<pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples>". 

Das Beispiel "rtp_pniocontroller_irt" liegt im Unterordner "cp16xx". 

3. Wählen Sie das zu importierende Projekt und markieren Sie die Option "Copy projects 
into workspace". 

 
4. Klicken Sie "Finish". 

5. Markieren Sie das gerade importierte Projekt und wählen Sie "Project > Properties". 

Die Projekteigenschaften werden geöffnet. 
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6. Wechseln Sie zu "VxWorks Info" und klicken Sie "Add Context...". 

 
7. Wählen Sie im Dialogfenster "Add Context" ein vorhandenes Image Projekt oder Source 

Build Projekt aus. 
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8. Klicken Sie "Finish". 

Es wird ein neuer Kontext erstellt. Projektspezifische Einstellungen werden nicht in den 
neuen Kontext übernommen. 

Sollten für die Beispiele weitere Einstellungen nötig sein, befindet sich im 
Projektverzeichnis die Scriptdatei "convert.bat". Ist dies nicht der Fall, wählen Sie "Project 
> Build Project" und übersetzen Sie das Projekt. 

9. Klicken Sie mit der rechten Maustaste auf das Beispielprojekt und wählen Sie aus dem 
Kontextmenü den Menüpunkt "Open Wind River VxWorks 7 Development Shell". 

 
10. Führen Sie in der Kommandozeile das Script "convert.bat" aus. 

 
Es werden alle für das Projekt spezifischen Defines und Bibliotheken zu den 
Projekteinstellungen hinzugefügt. 

 
  Hinweis 

TCF-Fehler, die während der Ausführung des Scripts "convert.bat" angezeigt werden, 
können Sie ignorieren. 

 

11. Wählen Sie "Project > Build Project" und übersetzen Sie das Projekt. 
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 Beispiele zur DMAPI-Schnittstelle 2 
 

 

Eine Liste der ausgelieferten Beispielprogramme und weitere Informationen zur DMAPI-
Schnittstelle finden Sie in der kompilierten HTML-Hilfedatei in folgendem Ordner: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\examples\dmapi"  

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples\dmapi" 
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 Beispiel für Funktionsaufrufe der hardwarenahen 
Funktionen 3 
 

 

Die Beispielapplikation "CPUIPC" verdeutlicht die Verwendung der Funktionsaufrufe für die 
hardwarenahen Funktionen. 

Sie finden den Source-Code des Beispiels zusammen mit den entsprechenden 
Generierungsdateien und dem ausführbaren Programm auf Ihrem Entwicklungsrechner in 
folgendem Verzeichnis: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\examples\cpuipc" 

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples\cpuipc" 

Für Wind River Workbench wird das Beispielprojekt "rtp_cpuipc" ausgeliefert. Dieses 
Beispielprojekt demonstriert die hardwarenahen Funktionen des SIMATIC IPC. Abhängig 
vom SIMATIC IPC, auf dem das Programm läuft, werden folgende Funktionen aufgerufen 
und demonstriert: 

● "ReadTemperature()" 

● "StartWatchdog()" 

● "TriggerWatchdog()" 

● "ReadFanStatus()" 

● "ReadBatteryStatus()" 

● Funktionen für den Betriebsstundenzähler 

● Setzen der User-LEDs  

● Lesen und Setzen der Echtzeit-Uhr 

Aufruf 
● rtp_cpuipc.vxe 
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 Beispiele für die Verwendung der DP-Base-Aufrufe 4 
 

 

Eine Beschreibung der DP-Base-Aufrufe finden Sie im Programmierhandbuch "SIMATIC 
NET Programmierschnittstelle DP-Base für CP 5613 /CP 5614" (Datei "mn_dp-base-
api_0.pdf"). 

In den Beispielen für den PROFIBUS-Treiber wird ein SIMATIC IPC als DP-Master 
betrieben. Ein weiterer SIMATIC IPC dient als DP-Slave. 

Für PROFIBUS wird eine Beispielapplikationen als Programmierbeispiel für DP-Master und 
DP-Slave ausgeliefert: 

● "dptest.c" 

Diese Beispielapplikation verdeutlicht die Verwendung der DP-Base-Aufrufe. Sie finden 
diese in folgendem Verzeichnis: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\examples\cp5622" 

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples\cp5622" 

Die Datei enthält den Code für die Funktionalität von Master und Slave. 

Die Beispiele müssen über Präprozessor-Schalter für Master- oder Slave-Betrieb kompiliert 
werden. 

Folgende Präprozessor-Schalter können verwendet werden: 
 
Präprozessor-Schalter Beschreibung 
#define MASTER_MODULE Durch Anwendung dieses Präprozessor-Schalters wird das 

Programmierbeispiel für den Master-Betrieb kompiliert. 
#define SLAVE_MODULE Durch Anwendung dieses Präprozessor-Schalters wird das 

Programmierbeispiel für den Slave-Betrieb kompiliert. 

Die folgende Tabelle zeigt, welche Beispielprojekte für Wind River Workbench ausgeliefert 
werden und welche Präprozessor-Schalter jeweils im Projekt aktiviert sind: 
 
Beispielprojekt Aktivierte Präprozessor-Schalter Beschreibung 
rtp_dpMaster #define MASTER_MODULE Master-Beispielprojekt 
rtp_dpSlave #define SLAVE_MODULE Slave-Beispielprojekt 

Bei der Initialisierung des PROFIBUS-Anschlusses wird die Firmware fw_5612.bin von der 
Festplatte geladen. Vor der ersten Verwendung müssen Sie daher die Firmware in den als 
Konfigurationsparameter DP_CP5622_FIRMWARE_PATH angegebenen Ordner auf dem Zielsystem 
kopieren. 
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Die Firmware-Datei finden Sie in folgendem Verzeichnis: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\profibus\firmware_cp5612" 

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\profibus\firmware_cp5612" 

4.1 rtp_dpMaster 
Dieses Beispiel zeigt den Zugriff auf den Master. Es demonstriert die Möglichkeiten des 
APIs, Informationen über die angeschlossenen Slaves zu erlangen. Nach dem Start geht 
das Programm in den Datenaustausch über. Die vom Slave empfangenen Eingangsdaten 
werden gelesen und als Ausgangsdaten zurück an den Slave gesendet. Auf der Konsole 
werden der Verbindungsstatus sowie die Eingangsdaten des Slaves angezeigt. 

Voraussetzung 
Die Applikation ist bezüglich der erzeugten PROFIBUS-Projektierung weitestgehend neutral. 

Die Firmware-Datei "fw_5612.bin" und die Beispiel-Projektierungsdatei 
"/ata0:1/dp_demo_master.ldb" müssen auf dem Zielsystem vorhanden sein. 

Die Minimalanforderung an die Projektierungsdatei ist ein projektierter Master und 
mindestens ein projektierter Slave.  

Aufruf 
● rtp_dpMaster.vxe 

4.2 rtp_dpSlave 
Dieses Beispiel verdeutlicht die Kommunikation des Slaves mit einem Master. Nach dem 
Start geht das Programm in den Datenaustausch über. Die vom Master empfangenen 
Ausgangsdaten werden inkrementiert und als Eingangsdaten zurück an den Master 
gesendet. Auf der Konsole werden der Verbindungsstatus sowie die Ausgangsdaten des 
Masters angezeigt. 

Voraussetzung 
Die Applikation ist bezüglich der erzeugten PROFIBUS-Projektierung weitestgehend neutral. 

Die Firmware-Datei "fw_5612.bin" und die Beispiel-Projektierungsdatei 
"/ata0:1/dp_demo_slave.ldb" müssen auf dem Zielsystem vorhanden sein. 

Die Minimalanforderung an die Projektierungsdatei ist der projektierte Slave. 

Aufruf 
● rtp_dpSlave.vxe 
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4.3 Projektieren des SIMATIC IPC für PROFIBUS 
Ein SIMATIC IPC kann für PROFIBUS mit folgender Projektierungssoftware projektiert 
werden: 

● SIMATIC Manager STEP7 V5.5 (Servicepack 3, Hotfix 3) 

● STEP 7 (TIA-Portal) ab V13 

Diese Projektierungssoftware ist nicht im Lieferumfang des SIMATIC IPC Support Package 
for VxWorks enthalten. 

Die zu den Programmierbeispielen gehörenden Projektierungen finden Sie nach erfolgter 
Installation auf Ihrem Entwicklungssystem unter folgendem Pfad: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\examples\cp5622" 

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples\cp5622" 
 
Datei Beschreibung 
Example_TIA.zap13 Projektierung für die Verwendung mit STEP 7 (TIA-Portal) V13 
Example_STEP7.zip Projektierung für die Verwendung mit STEP 7 V5.5 
dp_demo_master.ldb Projektierungsdatei für den DP-Master-Betrieb 
dp_demo_slave.ldb Projektierungsdatei für den DP-Slave-Betrieb 

Master und Slave sind wie folgt projektiert: 

● Master: 

Baudrate: 1,5 Mbps 

Adresse: 1 

● Slave: 

Baudrate: 1,5 Mbps 

Adresse: 3 
 
Slot DP-Kennung Bezeichnung E-Adresse A-Adresse 
0 32DE 4 Byte Eingang 1..4  
1 32DA 4 Byte Ausgang  1..4 
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Projektierung durchführen 
1. Öffnen Sie die Projektierungssoftware. 

2. Dearchivieren Sie das ausgelieferte Projekt oder erstellen Sie ein neues Projekt. 

Als Alternative können Sie auch die ausgelieferten, bereits vorkompilierten 
Projektierungsdateien nutzen. Überspringen Sie in diesem Fall den nächsten Schritt. 

3. Kompilieren Sie das Projekt. 

4. Kopieren Sie die kompilierte Projektierungsdatei (*.ldb) auf die Festplatte des 
SIMATIC IPC. 

5. Kopieren Sie die PROFIBUS-Firmwaredatei "fw_5612.bin" auf die Festplatte des 
SIMATIC IPC. 

Die Firmware finden Sie in folgendem Verzeichnis: 

– für VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\profibus\firmware_cp5612" 

– für VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\profibus\firmware_cp5612" 

6. Stellen Sie sicher, dass der Parameter "DP_CP5622_FIRMWARE_PATH" in Ihrem 
VxWorks Image Projekt auf das Verzeichnis zeigt, das die Firmware-Datei enthält. 

7. Beim Programmstart erwartet die Funktion "DP_start_cp()" den Pfad der 
Projektierungsdatei als Parameter. Wenn Sie eines der ausgelieferten 
Beispielprogramme verwenden, werden die folgenden Projektierungsdateien benutzt: 

– rtp_dpMaster: 

/ata0:1/dp_demo_master.ldb 

– rtp_dpSlave: 

/ata0:1/dp_demo_slave.ldb 
 

 Hinweis 

Die Onboard-Schnittstelle für PROFIBUS unterstützt maximal 64 DP-Slaves. 
 

 Hinweis 

Weitere Informationen zur Projektierung einer PC-Station finden Sie im SIEMENS Industry 
Online Support in folgendem Handbuch: "SIMATIC NET PC-Software PC-Stationen in 
Betrieb nehmen - Anleitung und Schnelleinstieg Projektierungshandbuch". 
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 Beispiele für PROFINET mit CP 16xx-Treiber 5 
 

 

Beispiele, welche die Verwendung der Zugriffsfunktionen verdeutlichen, finden Sie im 
mitgelieferten Programmierhandbuch "SIMATIC NET PROFINET IO-Base-
Anwenderprogrammierschnittstelle" (Datei "PGH_IO-Base_0.pdf"). 

Im Lieferumfang des SIMATIC IPC Support Package sind Beispielapplikationen für den 
CP 16xx-Treiber enthalten. In diesen Beispielen wird ein SIMATIC IPC mit CP 1616 onboard 
als PROFINET IO-Controller betrieben. Ein weiterer SIMATIC IPC mit CP 1616 onboard 
dient als PROFINET IO-Device. 

Für PROFINET werden drei Beispiel-Sourcecode-Dateien ausgeliefert: 

● "pniocontroller.c": 

Programmierbeispiel für IO-Controller 

● "pniodevice.c": 

Programmierbeispiel für IO-Device 

● "pnioload.c": 

Programmierbeispiel für CP-spezifische Funktionen 

Die Beispiel-Sourcecode-Dateien liegen in folgendem Verzeichnis: 

● VxWorks V6.9: 

 "<WIND_BASE>\target\3rdparty\siemens\examples\cp16xx" 

● VxWorks V7: 

 "<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples\cp16xx" 

Die Beispiele für IO-Controller und IO-Device können über Präprozessor-Schalter für eine 
bestimmte Betriebsart (RT, IRT) kompiliert werden. 

Folgende Präprozessor-Schalter können verwendet werden: 
 
Präprozessor-Schalter Beschreibung 
#define CONFIG_RT Durch Anwendung dieses Präprozessor-Schalters wird das jeweilige 

Programmierbeispiel für die Betriebsart RT kompiliert. 
#define CONFIG_IRT Durch Anwendung dieses Präprozessor-Schalters wird das jeweilige 

Programmierbeispiel für die Betriebsart IRT kompiliert. 
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Die folgende Tabelle zeigt, welche Beispielprojekte für Wind River Workbench ausgeliefert 
werden und welche Präprozessor-Schalter jeweils im Projekt aktiviert sind: 
 
Beispielprojekt Aktivierte Präprozessor-Schalter Beschreibung 
rtp_pniocontroller_rt #define CONFIG_RT Beispielprojekt für IO-Controller mit 

Verwendung der Betriebsart RT 
rtp_pniodevice_rt #define CONFIG_RT Beispielprojekt für IO-Device mit 

Verwendung der Betriebsart RT 
rtp_pniocontroller_irt #define CONFIG_IRT Beispielprojekt für IO-Controller mit 

Verwendung der Betriebsart IRT 
rtp_pniodevice_irt #define CONFIG_IRT Beispielprojekt für IO-Device mit 

Verwendung der Betriebsart IRT 
rtp_pnioload  Beispielprojekt für die CP-

spezifischen Funktionen. Hier 
werden keine weiteren 
Präprozessor-Schalter benötigt. 

5.1 rtp_pniocontroller 

Beschreibung 
Das Beispiel rtp_pniocontroller demonstriert die Kommunikationsmöglichkeiten des 
PROFINET-IO-APIs für einen PROFINET-Controller mit einem SIMATIC IPC mit CP 1616 
onboard als PROFINET-Device. 

Folgende Funktionalitäten des PROFINET-IO-APIs sind im Beispiel enthalten: 

● Verbindungsaufbau und -abbau 

● Datenaustausch 

Es werden die folgenden RTP-Applikationen ausgeliefert: 
 
Datei Beschreibung 
rtp_pniocontroller_rt.vxe Beispiel zur Verwendung mit der PROFINET-Betriebsart RT. 
rtp_pniocontroller_irt.vxe Beispiel zur Verwendung mit der PROFINET-Betriebsart IRT. 

Nach dem Start registriert das Programm alle nötigen Callback-Funktionen und geht in den 
Datenaustausch über. Solange der PROFINET-Controller keine PROFINET-
Applikationsbeziehung zum PROFINET-Device aufgebaut hat, sind die Eingangs- bzw. 
Ausgangsdaten ungültig und es wird auf der Konsole folgende Meldung ausgegeben: 

[DATA MARKED INVALID] 

RT 

In der Betriebsart RT sendet das Programm auf dem Controller die eigene Systemzeit (als 
ASCII-Zeichenfolge formatiert) zyklisch als Ausgangsdaten an das Device. Als 
Eingangsdaten empfängt der Controller zyklisch vom Device dessen Systemzeit als ASCII-
Zeichenkette und gibt sie auf der Konsole aus: 

Dev date: '<übertragene lokale Systemzeit des PNIO-Device>' 
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IRT 

In der Betriebsart IRT inkrementiert das Programm auf dem Controller im Callback des IRT-
Zyklus einen internen Zähler und sendet dessen Wert zyklisch als Ausgangsdaten an das 
Device. Als Eingangsdaten empfängt der Controller zyklisch vom Device einen gleichartig 
generierten Zählerwert und gibt ihn auf der Konsole aus: 

Dev irt: '<übertragener lokaler IRT-Zähler des PNIO-Device>' 

Durch Drücken der Taste "q" wird die PROFINET-Applikationsbeziehung abgebaut und das 
Programm beendet. 

Voraussetzung 
Für den korrekten Ablauf des Beispielprogramms wird als PROFINET-Device ein SIMATIC 
IPC mit CP 1616 onboard und laufendem rtp_pniodevice-Beispielprogramm benötigt. Dem 
Device muss der PROFINET-Name "PNIODEVICE1" zugewiesen sein. 

In der Betriebsart IRT müssen Controller und Device über den PROFINET Port 2 direkt 
verbunden werden. 

Aufruf 
RT  

● rtp_pniocontroller_rt.vxe 

IRT 

● rtp_pniocontroller_irt.vxe 

5.2 rtp_pniodevice 

Beschreibung 
Das Beispiel rtp_pniodevice demonstriert die Kommunikationsmöglichkeiten des PROFINET-
IO-APIs für ein PROFINET-Device mit einem SIMATIC IPC mit CP 1616 onboard als 
PROFINET-Controller. 

Folgende Funktionalitäten des PROFINET-IO-APIs sind im Beispiel enthalten:  

● Verbindungsaufbau und -abbau 

● Datenaustausch 

Es werden die folgenden RTP-Applikationen ausgeliefert: 
 
Datei Beschreibung 
rtp_pniodevice_rt.vxe Beispiel zur Verwendung mit der PROFINET-Betriebsart RT. 
rtp_pniodevice_irt.vxe Beispiel zur Verwendung mit der PROFINET-Betriebsart IRT. 
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Nach dem Start initialisiert das Programm das PROFINET-Device, registriert alle nötigen 
Callback-Funktionen und geht in den Datenaustausch über. Solange der PROFINET-
Controller keine PROFINET-Applikationsbeziehung zum PROFINET-Device aufgebaut hat, 
sind die Eingangs- bzw. Ausgangsdaten ungültig und es wird auf der Konsole folgende 
Meldung ausgegeben: 

[DATA MARKED INVALID] 

RT 

In der Betriebsart RT sendet das Programm auf dem Device die eigene Systemzeit (als 
ASCII-Zeichenfolge formatiert) zyklisch an den Controller. Das Device empfängt zyklisch 
vom Controller dessen Systemzeit als ASCII-Zeichenkette und gibt sie auf der Konsole aus: 

Ctr date: '<übertragene lokale Systemzeit des Controllers>' 

IRT 

In der Betriebsart IRT inkrementiert das Programm auf dem Device im Callback des IRT-
Zyklus einen internen Zähler und sendet dessen Wert zyklisch an den Controller. Das 
Device empfängt zyklisch vom Controller einen gleichartig generierten Zählerwert und gibt 
ihn auf der Konsole aus: 

Ctr irt: '<übertragener lokaler IRT-Zähler des Controllers>' 

Durch Drücken der Taste "q" wird die PROFINET-Applikationsbeziehung abgebaut und das 
Programm beendet. 

Voraussetzung 
Für den korrekten Ablauf des Beispielprogramms wird als PROFINET-Controller ein 
SIMATIC IPC mit CP 1616 onboard und laufendem rtp_pniocontroller-Beispielprogramm 
benötigt. In der Betriebsart IRT müssen Controller und Device über den PROFINET Port 2 
direkt verbunden werden. 

Aufruf 
RT  

● rtp_pniodevice_rt.vxe 

IRT 

● rtp_pniodevice_irt.vxe 
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5.3 rtp_pnioload 

Beschreibung 
Das Beispielprogramm rtp_pnioload demonstriert die Möglichkeiten der CP-spezifischen 
Funktionen, die mit dem PROFINET-IO-API angeboten werden. 

Folgende Funktionalitäten des PROFINET-IO-APIs sind im Beispiel enthalten: 

● Laden der Projektierung 

● Update der Firmware der PROFINET-Schnittstelle 

● Reset der PROFINET-Schnittstelle 

Vorgehensweise für das Laden einer Projektierung 

Für das Laden einer Projektierung benötigen Sie eine Projektierungsdatei im XDB-Format. 
Für die PROFINET-Beispielprogramme werden entsprechende Projektierungsdateien 
mitgeliefert. Nach dem Übertragen einer XDB-Datei auf das Zielsystem laden Sie die 
Projektierung mit folgendem Aufruf: 

[vxWorks *]# rtp_pnioload.vxe -l<Pfad und Dateiname der XDB-Datei> 

Vorgehensweise für das Update der Firmware der PROFINET-Schnittstelle 

Für ein Firmware-Update benötigen Sie eine Firmware-Datei im FWL-Format. Die aktuell zur 
Verwendung mit dem SIMATIC IPC Support Package for VxWorks freigegebene Firmware 
finden Sie im Verzeichnis: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\profinet\cp16xx\firmware" 

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\profinet\cp16xx\firmware" 

Nach dem Übertragen einer FWL-Datei auf das Zielsystem starten Sie das Update mit 
folgendem Aufruf: 

[vxWorks *]# rtp_pnioload.vxe -f<Pfad und Dateiname der Firmware-Datei> 

Vorgehensweise für den Reset der PROFINET-Schnittstelle 

Den Reset der PROFINET-Schnittstelle starten Sie mit folgendem Aufruf: 

[vxWorks *]# rtp_pnioload.vxe -r<ResetType> 
 
ResetType Beschreibung 
0 Es wird der ResetType PNIO_CP_RESET_SAFE verwendet. 
1 Es wird der ResetType PNIO_CP_RESET_FORCE verwendet. 

Voraussetzung 
Für den korrekten Ablauf des Beispielprogramms wird ein SIMATIC IPC mit einer 
PROFINET onboard Schnittstelle benötigt. 
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Aufruf 
Projektierung laden 

● rtp_pnioload.vxe -l<Pfad und Dateiname der XDB-Datei> 

Firmwareupdate 

● rtp_pnioload.vxe -f<Pfad und Dateiname der Firmware-Datei> 

Reset  

● rtp_pnioload.vxe -r<ResetType> 

 

5.4 Projektierung des SIMATIC IPC für PROFINET 

Projektierung des SIMATIC IPC 
Ein SIMATIC IPC mit dem CP1616 onboard kann für PROFINET mit folgender 
Projektierungssoftware projektiert werden: 

● NCM PC ab Version V5.5 SP3 aus DK-16xx PN IO 

● STEP 7 (TIA-Portal) ab V13 

● STEP 7 ab Version 5.5 SP3 mit HSP 1084 und 1085 (CP 1616 onboard V2.6) 

● IO-Base-Anwenderprogrammierschnittstelle 

Diese Projektierungssoftware ist nicht im Lieferumfang des SIMATIC IPC Support Package 
für VxWorks enthalten.  

Die zu den Programmierbeispielen gehörenden Projektierungen für den IO-Controller finden 
Sie nach erfolgter Installation auf Ihrem Entwicklungssystem unter folgendem Pfad: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\examples\cp16xx" 

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples\cp16xx" 
 
Datei Beschreibung 
rt.zip Projektierung für die Verwendung mit STEP7 oder NCM PC mit Betriebsart RT. 
rt.xdb Projektierung für den Download über die IO-Base-Anwenderprogrammierschnittstelle für 

die Betriebsart RT. 
rt.zap13 Projektierung für die Verwendung mit STEP 7 (TIA-Portal) V13 mit Betriebsart RT. 
irt.zip Projektierung für die Verwendung mit STEP7 oder NCM PC mit Betriebsart IRT. 
irt.xdb Projektierung für den Download über die IO-Base-Anwenderprogrammierschnittstelle für 

die Betriebsart IRT. 
irt.zap13 Projektierung für die Verwendung mit STEP 7 (TIA-Portal) V13 mit Betriebsart IRT. 
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Das Device ist wie folgt projektiert: 

IRT: 
 
Slot Modul E Adresse A Adresse 
1 PNIODEV1   
2 20 Byte DI/DO isochron 0..19 0..19 
 Controller und Device müssen am PROFINET Port 2 direkt miteinander verbunden werden. 

RT: 
 
Slot Modul E Adresse A Adresse 
1 PNIODEV1   
2 20 Byte DI/DO 0..19 0..19 

Projektieren mit STEP 7 oder NCM PC 
Vorgehensweise wie folgt: 

1. Dearchivieren Sie mit der Projektierungssoftware vor Ausführung eines Beispiels die 
ausgelieferte ZIP-Datei. 

2. Übersetzen Sie die darin enthaltene Projektierung. 

3. Laden Sie die Projektierung in den PROFINET-IO-Controller. 

Projektieren über IO-Base-Anwenderprogrammierschnittstelle 
Vorgehensweise beim Download über die IO-Base-Anwenderschnittstelle: 

1. Übertragen Sie vor der Ausführung eines Beispiels die ausgelieferte XDB-Datei auf das 
Zielsystem. 

2. Laden Sie die Projektierung unter Verwendung der IO-Base-Funktion 
SERV_CP_download() in den PROFINET-IO-Controller. 

– Die Funktion SERV_CP_download() ist im Programmierhandbuch der SIMATIC NET 
IO-Base-Anwenderprogrammierschnittstelle beschrieben. 

– Im Lieferumfang des SIMATIC IPC Support Package for VxWorks ist das 
Programmierbeispiel pnioload enthalten, das die Funktion SERV_CP_download() 
verwendet. Das Programm pnioload ist als Kernel Komponente im CP 16xx-Treiber 
bereits enthalten und kann auf der Konsole mit dem Befehl pnioload "-
l/ata0:1/rt.xdb" aufgerufen werden. 

Weitere Informationen zur Projektierung einer PC-Station finden Sie im SIEMENS Industry 
Online Support in folgendem Handbuch: "SIMATIC NET PC-Software PC-Stationen in 
Betrieb nehmen - Anleitung und Schnelleinstieg Projektierungshandbuch". 
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Beispiele, welche die Verwendung der Zugriffsfunktionen verdeutlichen, finden Sie im 
mitgelieferten Programmierhandbuch "SIMATIC NET PROFINET IO-Base-
Anwenderprogrammierschnittstelle" (Datei "PGH_IO-Base_0.pdf"). 

In dem Beispiel für den PN-Treiber wird ein SIMATIC IPC als PROFINET-Controller 
betrieben. Ein weiterer SIMATIC IPC mit CP1616 onboard dient als PROFINET-Device. 

Für PROFINET werden vier Beispiel-Sourcecode-Dateien ausgeliefert: 

● "pnd_test.c": 

Beispielprogramm für den PN-Treiber  

● "pnd_test_helper.c": 

Hilfsfunktionen für das Beispielprogramm 

● "pnd_test_iob_core.cpp": 

PROFINET Zugriffs- und Callbackfunktionen für das Beispielprogramm 

● "pnd_test_iodu.c": 

IODU Testfunktionen für das Beispielporgramm 

Die Beispiel-Sourcecode-Dateien liegen in folgendem Verzeichnis: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\examples\pn" 

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples\pn" 

Es muss der Präprozessor-Schalter "PNIO_PNDRIVER" bei Verwendung des PN-Treibers 
gesetzt werden. 

Für Wind River Workbench wird das Beispielprojekt "rtp_pntest" ausgeliefert. 

Als PROFINET-Device wird in der Beispielprojektierung ein weiterer SIMATIC IPC mit 
onboard PROFINET-Schnittstelle verwendet. Als Applikation auf dem Device kann das 
PROFINET CP16xx Beispiel "rtp_pniodevice_rt" eingesetzt werden. 

Da das PN-Treiber-Beispielprogramm von der Projektierung unabhängig ist, können Sie 
auch andere Geräte als Device verwenden. In diesem Fall muss die mitgelieferte 
Beispielprojektierung angepasst bzw. eine neue Projektierung erstellt werden. 
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6.1 rtp_pntest 

Beschreibung 
Das Beispiel rtp_pntest ist interaktiv und demonstriert alle für den PN-Treiber verfügbaren 
PROFINET-Aufrufe. Das Programm ist unabhängig von der Projektierung, kann also 
grundlegend mit einem beliebigen projektierten PROFINET-Slave verwendet werden. Diese 
Beschreibung bezieht sich auf die Verwendung der mitgelieferten Beispielprojektierung. Es 
wird die folgende RTP-Applikation ausgeliefert: 

● rtp_pntest.vxe 

Nach dem Programmstart wird folgendes Menü ausgegeben: 

PROFINET PN Driver | test program 

=============================== 

1....Help (show menu) 

=============================== 

2....Open Controller 

3....Close Controller 

=============================== 

4....Set Mode PNIO_MODE_OFFLINE 

5....Set Mode PNIO_MODE_CLEAR 

6....Set Mode PNIO_MODE_OPERATE 

=============================== 

7....Device Activate 

8....Device Deactivate 

=============================== 

9....I&M Data Read 

10...I&M Data Write 

=============================== 

11...IO Data Read/Write 

=============================== 

0... QUIT 

Mit Eingabe von "2" wählen Sie den Menüpunkt "Open Controller" und initialisieren somit 
den PROFINET-Controller. 

Nach einer kurzen Wartezeit können Sie den Controller mit dem Menüpunkt 6 in den 
Datenaustausch-Modus schalten und anschließend mit Menüpunkt 11 Daten lesen bzw. 
schreiben. 
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Solange Sie keine Ausgangsdaten schreiben, sind diese als ungültig markiert. Auf dem 
angeschlossenen PROFINET-Device mit laufender Beispielapplikation "rtp_pniodevice_rt " 
wird daher die folgende Ausgabe angezeigt: 

[DATA MARKED INVALID] 

Die im Controller-Beispielprogramm gesetzten Ausgangsdaten werden im Device als ASCII-
Zeichenfolge interpretiert und ausgegeben. Daher empfielt es sich, als Ausgangsdaten nur 
den Wert druckbarer ASCII-Zeichen einzugeben. Auf dem PROFINET-Device wird folgende 
Ausgabe angezeigt: 

Ctr date: '<übertragene Zeichenfolge des PNIO-Controller>' 

Da das PROFINET-Device als Eingangsdaten die Systemzeit als Zeichenfolge setzt, 
müssen Sie die im Controller-Programm gelesenen Eingangswerte als ASCII-Zeichen 
interpretieren. 

Voraussetzung 
Das Beispielprogramm ist von der Projektierung unabhängig. Für den korrekten Ablauf des 
Beispielprogramms mit der Beispielprojektierung wird als PROFINET-Device ein 
SIMATIC IPC mit CP1616 onboard und laufendem Beispielprogramm "rtp_pniodevice_rt " 
benötigt. Dem Device muss der PROFINET-Name "PNIODEVICE1" zugewiesen sein. 

Aufruf 
● rtp_pntest.vxe 
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6.2 Projektierung des SIMATIC IPC für PROFINET mit PN-Treiber 
Ein SIMATIC IPC mit dem PN-Treiber kann für PROFINET mit folgender 
Projektierungssoftware projektiert werden:  

● STEP 7 (TIA-Portal) ab V13 mit HSP0074 

Diese Projektierungssoftware ist nicht im Lieferumfang des SIMATIC IPC Support Package 
for VxWorks enthalten. Die zu dem Programmierbeispiel gehörige Projektierung für den 
Controller finden Sie nach erfolgter Installation auf Ihrem Entwicklungssystem unter 
folgendem Pfad: 

● VxWorks V6.9: 

"<WIND_BASE>\target\3rdparty\siemens\examples\pn" 

● VxWorks V7: 

"<WIND_BASE>\pkgs\siemens\simatic_ipc_sp-w.x.y.z\examples\pn" 
 
Datei Beschreibung 
pndrv_example.xml Projektierungsdatei für den PN-Treiber 
pndrv_example.zap13 Projektierung für die Verwendung mit STEP 7 (TIA-Portal) V13 

Das zugehörige Device ist wie folgt projektiert: 
 
Slot Modul E Adresse A Adresse HW-Kennung 
1 CP 1616 onboard V2.6   263 

PNIODEV1   259 
2 20 Byte DI/DO 0..19 0..19 266 

Projektieren mit STEP 7 (TIA Portal) V13 
1. Dearchivieren Sie mit der Projektierungssoftware vor Ausführung des Beispiels die 

ausgelieferte ZAP13-Datei. 

2. Übersetzen Sie die darin enthaltene Projektierung. 

3. Übertragen Sie die erstellte Projektierung auf das Zielsystem. 

Die Projektierungsdatei "Station_Controller.PN Driver_1.PNDriverConfiguration.xml" 
finden Sie im Projektverzeichnis unter "\AdditionalFiles\PNDriver\". 

4. Tragen Sie in der Kernel-Konfiguration Ihres VxWorks Image Projects als Wert des 
Parameters PN_CONFIGURATION_FILE den Pfad und Dateinamen der 
Projektierungsdatei ein. 
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